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SYSTEM AND METHOD FOR LINKING
STREAMS OF MULTIMEDIA DATA TO
REFERENCE MATERIAL FOR DISPLAY

Matter enclosed in heavy brackets | ] appears in the
original patent but forms no part of this reissue specifica-
tion; matter printed in italics indicates the additions
made by reissue.

Note: More than one reissue patent application has been
filed for the reissue of U.S. Pat. No. 5,822,720. The reissue

patent applications arve U.S. Reissue patent application Ser.

No. 11/064,519, filed Feb. 24, 2005, now U.S. Reissue Pat. No.

Re. 40,731, U.S. Reissue patent application Ser. No. 12/480,
556, filed Jun. 8§, 2009, now U.S. Reissue Pat. No. Re. 43,633,

and the present U.S. Reissue patent application Ser. No.
13/603,315, filed Sep. 4, 2012, which is a continuation reissue

application of U.S. Reissue patent application Ser. No.
12/480,556.

This 1s a continuation of application Ser. No. 08/197,157
filed Feb. 16, 1994 now abandoned.

BACKGROUND OF THE INVENTION

1. Technical Field

The present invention relates to indexing displayed ele-
ments. More particularly, the present invention relates to a
novel indexing scheme that 1s usetul 1n such applications as
learning a foreign language, for example a language based
upon an 1deographic alphabet, such as Japanese.

2. Description of the Prior Art

As the global economy turns the world’s many nations into

what media visionary Marshall McLuhan referred to as a
global village, the need to learn and use new or specialized
information, such as a language other than one’s native lan-
guage, becomes increasingly important. For example, there 1s
a tremendous international demand for information related to
Japan. Inside Japan, there 1s an abundance of information
available 1n the Japanese language 1n numerous media forms.
Japan has five national newspapers, seven major broadcasting
networks, and several hundred book and magazine publish-
ers. Japanese television focuses on the most obscure topics;
and there are special interest magazines covering the full
spectrum of Japanese society. Speakers of the Japanese lan-
guage can find imformation on just about any topic 1magin-
able. Unfortunately, outside of Japan this information 1s 1n
short supply and the information that i1s available 1s primarily
in English.
Individuals trying to learn about Japan are faced with the
dilemma of either relying on English language sources or
going through the pains of learning Japanese. English lan-
guage information on Japan must go through the translation
process. This results 1n time delays in obtaining necessary
information, as well as in distortions 1n meaning. Further-
more, economics itself places restrictions on what informa-
tion makes 1t’s way into English and what mnformation does
not. For general and introductory information on Japan, the
English-based media 1s providing a valuable service. But for
people who want to do more than scratch the surface, such
information 1s far from suificient.

A large number of non-native speakers have sought to
study Japanese in universities or in prolessional language
schools. In recent years, the interest level 1n Japanese among
first year level college students has soared, such that it 1s rated
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people studying Japanese in the mid-1980°s in the United
States was 50,000. This number has recently grown to 400,
000 persons. Butthe study of Japanese language 1s plagued by
the burdens of learning Kanji, the ideographic alphabet in
which Japanese 1s written. Thus, the standing room only
first-year Japanese language class 1n many universities soon
becomes the almost private lesson-like third year class due to
student attrition resulting from the difficulty of mastering
Kanyji.

The situation 1n Japan for foreigners is not much more
encouraging. The cost of living 1n Japan poses a major barrier
for both business people and students. There are currently
over 300,000 United States citizens working or studying in
Japan. But in recent years, foreign companies have been
cutting their foreign stafl. This, 1n part, has been 1n response
to the enormous expense associated with maintaining them in
Japan; but 1t 1s also a statement about the effectiveness of a
large percentage of these people, who typically possess no
Japanese language skills or background. Nevertheless, the
necessity to do business i Japan 1s clear to most major United
States companies, and access to Japan’s mside information 1s
critical to the success of such companies.

The situation 1n Japanese universities 1s also discouraging.
There are currently about 30,000 foreign students 1n Japanese
umversities, compared to a total of over 300,000 foreign
students studying in the United States. Ninety percent of the
foreign students in Japan are from Asia, while there are less
than 1,000 students in Japan from the United States. The cost
of living and housing again contribute greatly to this disparity,
but the language barrier must be seen as the prime hurdle that
causes students to abandon the attempt to explore Japan. In
the future, the desirability for students and researchers to
work 1n Japan should increase due to the growth of “science
cities” and the increase 1n the hiring of foreign researchers by
Japanese corporations. The burden of studying Japanese,
however, remains.

In total there are over 60,000 people enrolled 1n Japanese
language programs in Japan; and according to the Japan
Foundation, there are approximately 1,000,000 Japanese lan-
guage students worldwide, with a total of over 8,200 Japanese
language instructors 1n 4,000 1nstitutes. However, without a
more effective and productive methodology for reading Japa-
nese and for building Japanese language vocabulary, the level
and breadth of the information making 1ts way to non-natives
should not be expected to improve.

The foregoing 1s but one example of the many difficulties
one 1s faced with when acquiring or using difficult or unfa-
miliar material. The first challenge anyone reading a difficult
text, 1s faced with 1s the 1ssue of character recogmition and
pronunciation. For example, a student of the Japanese lan-
guage spends many Irustrating hours counting character
strokes and looking up characters 1n a dictionary. Challenges
such as this are the primary reason so many people give up on
Japanese after a short trial period. It 1s also the reason that
people who continue to pursue the language are unable to
build an effective vocabulary.

Knowing the “yomai1” or pronunciation or reading of a word
1s essential to memorize and assimilate the word 1nto one’s
vocabulary. This allows the student to read a word 1n context
and often times deduce 1ts meaning. But 1n many cases, the
word may be entirely new to the reader, or 1t may be a usage
that the reader has never seen. Looking up the word 1n the
dictionary or asking a native speaker are the only options
available to a student. Once the yomi for the word 1s known,
1.¢. the meaning and understanding of the word 1n context, the
final challenge 1s to memorize the word and make 1t a part of
a usable vocabulary.
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The sheer number of characters 1n 1deographic alphabets,
such as Kanji, presents umique challenges for specitying and

identifying individual characters.

Various schemes have been proposed and descriptions can
be found 1n the literature for the entry of Kanj1 characters into
computers and the like.

See, for example, Y. Chu, Chinese/Kanj1 Text and Data
Processing, IEEE Computer (January 1985); I. Becker, Typ-
ing Chinese, Japanese, and Korean, IEEE Computer (January
1985); R. Matsuda, Processing Information in Japanese,
IEEE Computer (January 1985); R. Walters, Design of a
Bitmapped Multilingual Workstation, IEEE Computer (Feb-
ruary 1990); and J. Huang, The Input and Output of Chinese
and Japanese Characters, IEEE Computer (January 1985).

And, see J. Monroe, S. Roberts, T. Knoche, Method and

Apparatus for Processing Ideographic Characters, U.S. Pat.
No. 4,829,583 (9 May 1989), in which a specific sequence of
strokes 1s entered 1nto a 9x9 matrix, referred to as a training
square. This sequence 1s matched to a set of possible corre-
sponding 1deographs. Because the matrix senses stroke start-
ing point and stroke sequences based on the correct writing of
the 1deograph to be identified, this system cannot be used
elfectively until one has mastered the writing of the 1deo-
graphic script. See, also G. Kostopoulos, Composite Charac-
ter Generator, U.S. Pat. No. 4,670,841 (2 Jun. 1987); A.
Carmon, Method and Apparatus For Selecting, Storing and
Displaying Chinese Script Characters, U.S. Pat. No. 4,937,
745 (26 Jun. 1990); and R. Thomas, H. Stohr, Symbol Defi-
nition Apparatus, U.S. Pat. No. 5,187,480 (16 Feb. 1993).

Atext revision system 1s disclosed in R. Sakai, N, Kitajima,
C. Oshima, Document Revising System For Use With Docu-
ment Reading and Translation System, U.S. Pat. No. 35,222,
160 (22 Jun. 1993), 1n which a foreigner having little knowl-
edge of Japanese canrevise misrecognized imaged characters
during translation of the document from Japanese to another
language. However, the system 1s provided for commercial
translation services and not intended to educate a user 1n the
understanding or meaning of the text.

Thus, although much attention has been paid, for example,
to the writing, identification, and manipulation of ideographic
characters, none of these approaches are concerned with pro-
viding a language learning system. The state of the art for
ideographic languages, such as Japanese, does not provide an
approach to learning the language that meets the four primary
challenges discussed above, 1.e. reading the language (for
example, where an 1deographic alphabet 1s used), compre-
hending the meaning of a particular word encountered while
reading the language, understanding the true meaning of the
word within the context that the word 1s used, and including,
the word 1n a personal dictionary to promote long term reten-
tion of the meaning of the word. A system that applies this
approach to learning a language would be a significant
advance 1n bridging the gap between the world’s diverse
cultures because of the increased understanding that would
result from an 1mproved ability to communicate with one
another. Such system would only be truly usetul 11 it were
based upon an indexing scheme that allowed meaningiul
manipulation and display of the various elements of the lan-

guage.

SUMMARY OF THE INVENTION

The mnvention provides a unique system for indexing dis-
played elements and finds ready application, for example in a
language learning system that enhances and improves the
way non-natives read foreign languages, for example the way
a native English speaker reads Japanese. The language learmn-
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4

ing system provides a more effective way for people to read
and improve their command of the foreign language, while at
the same time communicating insightful and relevant cul-
tural, social, and economic information about the country.

The learming model used by the language learning system
1s straightforward and 1s based upon methods that are familiar
to most learners of foreign languages. The system addresses
the four challenges of reading a foreign language, such as
Japanese: 1.e. reading the foreign word or character, such as
Kanj1 1n the case of a language having an 1deographic alpha-
bet, such as Japanese; comprehending the meaning of the
word; understanding the word 1n context; and including the
word 1n a personal vocabulary.

The exemplary embodiment of the invention includes one
or more foreign language books that are read on an electronic
display of a personal computer. English word references are
available for each word in such books. The definitions of such
words are derived from well known foreign language dictio-
naries. Withregard tothe J apanese language, the system saves
significant amounts of time and effort by eliminating the need
for the user to look up Japanese characters 1n a Kanji dictio-
nary.

When one uses the system, the pronunciations or readings
(‘vomi’) for all words are immediately viewable 1n a pop-up
window without accessing a disk based database, for example
by clicking a mouse on a selected word or phrase. In the same
pop-up window, the system provides an English reference to
any word that 1s also selected by clicking on the selected word
or phrase. The system provides extensive notes for difficult
phrases and words not normally found in a dictionary, and
includes a relational database designed for managing and
studying words. This allows a user to build a personal data-
base of words that he would like to master. Words may also be
entered from other sources that are currently 1n paper or other
clectronic formats. A unique mndexing scheme allows word-
by-word access to any of several external multi-media refer-
ences.

BRIEF DESCRIPTION OF THE DRAWINGS

FIG. 1 1s a block schematic diagram of a language learning
system according to the ivention;

FIG. 2 1s a flow diagram in which the mechanism for
indexing and linking text to external references 1s shown
according to the invention;

FIG. 3 1s a screen display showing a highlighted Japanese
word and a pop-up menu, including an English reference to
the Japanese word, according to the mnvention;

FIG. 4 15 a screen display showing a highlighted Japanese
word and a pop-up menu, including Japanese language anno-
tations of the Japanese word, according to the invention; and

FIG. S 1s a screen display showing a Japanese word listed 1n
a personal dictionary, as well as a word control palette,
according to the invention.

DETAILED DESCRIPTION OF THE INVENTION

The mmvention provides a system that 1s designed to
enhance and improve the way one reads or learns to read a
difficult text, such as a foreign language, especially a lan-
guage based upon an i1deographic alphabet, such as Kanji
which 1s used 1n the Japanese language. The text may be any
of actual text based material, or audio, video, or graphic based
information. In the language learning application, the system
1s modeled on the process by which the foreign language 1s
read and addresses the problems most persons face when
reading a language that 1s different from their own.
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The exemplary embodiment of the invention 1s based upon
two powerftul functional modules that provide a comprehen-
stve approach to reading and learning a foreign language,
such as Japanese. The first module 1s an electronic viewer that
gives the user access to reference imnformation on each word 1n
the electronic text at a word by word level. The second mod-
ule 1s a relational database that allows a user to create word
lists with practically no limit 1n size. The two modules are
integrated to provide the user with everything needed to read
the foreign language quickly and enjoyably, as well as to build
their own 1individual vocabulary.

FIG. 1 1s a block schematic diagram of an exemplary
embodiment of the invention that implements a language
learning system. An electronic book and/or a multi-media
source matenal 1s provided as a teaching resource. A text file
10 and/or a multimedia source 14, consisting of an audio/
video file 11 and synchronized text 13, which may include
sound, 1mages, and/or video 1s edited during construction of a
linked text database by a visual editor 19 that used to build a
wordified database 20. The database 20 sources a grammar
parser 23 and a link engine 22 that builds an index 21 which,
in turn, locates each textual and audio/video reference 1n the
source material. The imndex provides a location for each ret-
erence 1n a database 12 that includes a relational database
engine 135, and linkable entities, such as text references 16,
audio references 17, graphic references 18, and the like.

The link engine 22 outputs the selected text to a word 11st 28
derived from the 1nput text file 10 and/or audio/video infor-
mation 14, and also outputs the reference information 24,
consisting of linkable entities 25, 26, 27, which are dertved
from the indexed database 12. The indexor/viewer 29 creates
amulti-media resource 30, such as a file 33 that was processed
as described above to produce a data resource 34, an oifset
index 35, and linked entities 36 to the data resource for access
by the user.

A user mterface 32 to the system includes an electronic
viewer 43 that runs along with the system application pro-
gram 42 and provides the following functional elements:
index management 37, user display 38, a table of contents 39,
a pop-up display 40, and a personal dictionary 41.

The electronic viewer module 1s used to view and read the
clectronic books provided with the language learning system.
The module 1includes the following features:

1. One-click, pop-up information for all words containing
foreign language words;

2. A word display palette;

3. A contents menu for each book;

4. Search functions;

5. Selectable browse and edit modes; and

6. The ability to copy words and associated information 1nto
personal dictionary.

The personal dictionary 1s a relational database that 1s
optimized to manage and study words. Unlike electronic dic-
tionaries, where only the word entries of the dictionary are
searchable, the personal dictionary of the system herein
allows one to search on each of eight or more keys associated
with a word.

The following functions are supported by the personal
dictionary:

1. Display of words 1n an easy to read, easy to access format;

2. Full relational database capabilities for the following: the
word, the pronunciation, English reference, notes, cat-
egory, source, priority, and review date;

. Search capabilities for any item;

. Capabilities to store an unlimited number of words;

. A flash word feature to allow seli-testing in sorted or
random order; and
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6

6. Capabilities to review words sorted by any word key.

The personal dictionary also allows the user to enter words
from other sources that are currently 1n paper or other elec-
tronic formats. For example, a user can copy all the words that
they have in paper format from study lists and notes. With this
feature, a student can have all of his study matenals in one
casy to access database. Users can also import and export data
in a text format supported by standard word processor and
spreadsheet programs.

The exemplary personal dictionary includes a base 500-
word vocabulary list designed for the beginning student. A
variety of words are included related to such general topics as:
foods and drink, family, health, the body, commuting and
transportation, environment, economics, finance, politics,
companies, industries, computers, sports, and the language
itself.

The system includes one or more electronic books. The
words 1n each book 1s fully supported with readings, English
references, and hypernotes. In the exemplary embodiment of
the invention there are typically over 10,000 words, as well as
over 1,000 notes presented 1n an easy to read, easy to memo-
rize format.

The English reference feature of the system provides basic
information to help users understand the word 1n its context.
For each word, a generalized definition of the word 1s pro-
vided. The pop-up fields are used to give the user a quick
reference to the word and to allow the user to continue reading
or reviewing the text.

Current electronic book formats provide simple hyperlinks
in what 1s termed hypertext or multimedia. Hyperlinks to date
have been simple pointers that directly link text with other
text, graphics, or sound within the text file itself. For reference
materials, such as electronic encyclopedias, and dictionaries,
hyperlinks provide a quick and easy way to find related mate-
rial to a topic or subject. However, these links must be hard
coded and are therefore cumbersome to author. The format of
the system herein described provides a new means of relating,
text, pictures, and/or video with information to enrich and
expand the impact of every element 1n a text, picture, or video.
This format differs from current electronic books which only
link text with other parts of text or content.

In the new format of the present system, every word or
sound, for example, can be linked to information not con-
tained within the text using an indexing method that maps a
single word or phrase to a table that contains external refer-
ence material. This reference can be in the form [or] of text,
graphics, images, movies, and/or sound. Thus, the resource
materials, such as the text, remains unaltered and therefore
compact in terms of file size. Thus, the resource materials, for
example the text, takes up less disk space and runs faster.

FIG. 2 1s a flow diagram in which the mechanism for
indexing and linking text to external references 1s shown
according to the invention. To find a reference to a particular
word or other selected entry displayed on the screen, the user
clicks the text that 1s viewed with a pointing device, such as a
mouse (200). The click position 1s determined and used to
calculate an offset value within the text (200). In the example
shown 1n FIG. 2, the user clicks at a particular location, e.g.
horizontal and vertical coordinates 100 and 75, respectively,
and an ofiset value of 25 1s returned. The offset value is
compared to the start and end position indices stored 1n a
look-up table (201, 202). The link between the selected text
and the external reference 1s resolved (203), and the external
reference 1s retrieved and displayed to the user (204). In the
example of FIG. 2 an offset of 25 1s located at the look-up
table location having a start point o1 20 and an end point of 27
and 1s linked to text located at position 200. As can be seen




US RE45,085 E

7

from the look-up table (202), the link may be to text, sound,
pictures, and video. In the example, the text linkage 1s to the
English language word “Japanese economy”.

The actual indexing process 1s completed 1n several steps,
including word cuts, linking, and compilation.
Word Cuts

The word cutting process 1s accomplished using a simple
visual editor, for example a point and click system using a
pointing device, such as a mouse. The process divides the text
into the individual components of text that are linked with the
additional reference material. The original text 1s provided by
a publisher 1n electronic form 1n a raw binary text format (e.g.
an ASCII text file or other word processor file). This text 1s
then divided up 1nto the component word or phrases 1n prepa-
ration for the next step.

Linking,

The linking process takes the text after the word cut process
and links 1t to an external reference. The database 20 sources
a grammar parser 23 and a link engine 22 that builds an index
21 which, 1n turn, locates each textual and audio/video refer-
ence 1n the source material. In the case of language learning,
the component words and phrases are linked to a foreign
language dictionary. In other cases, links may be made to
other reference materials, such as graphics and/or sound.
Compilation

After linking, the text and references are compiled. During
compilation, the cut text 1s reassembled to create an 1mage of
the text that the end user sees. At this point additional format-
ting may be applied to the text for final display. Indices of the
component words and phrases are built with links to the
reference material and duplicate references are consolidated
to conserve memory and storage requirements.

A key feature of the system format 1s the method by which
the original book text 1s indexed and linked with the external
references. During the compile process an image of the text 1s
created. When the image 1s created, the cuts are indexed based
upon the position offset from the beginning of the text. The
start and end points of the cut text are recorded 1n a look-up
table along with the links to external references. The number
and type of links for any component 1s dynamic. This means
that a single entry could have several different references
attached to it, each containing different forms of data.

The user interacts with the electronic book using a pointing,
device. When the user “clicks” within the text image, the
location of the pointer 1s determined. The location 1s con-
verted 1nto a position offset from the beginning of the text and
used to determine which component word or phrase was
selected. The process mvolves comparing the offset with the
start and end values stored in the look-up table as discussed
above 1n connection with FIG. 2. When the offset value falls
between a component’s start and end points, a match 1s made
and the external references can be resolved.

English Reference

FIG. 3 1s a screen display showing a highlighted Japanese
word and a pop-up menu, including a translation of the Japa-
nese word, according to the mnvention. The following section
explains the English reference pop-ups associated with each
word:

The English reference i1s mtended to give the user basic
information to help him understand a selected word 1n 1ts
context. A majority of the word definitions found in the
English reference are not the direct translation of the word 1n
that particular context. They are mostly generalized defini-
tions of the given word. These pop-up fields give the user a
quick reference to the word and allow him to continue reading
or reviewing the text without the need to stop and access a
dictionary. In applying the invention to other languages, for
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example Korean or Chinese, or to difficult materials, such as

highly technical or complex matters, appropriate external

references should be selected.

In the exemplary embodiment of the invention, a priority 1s
placed on making the text readable, rather than on creating a
detailed grammatical description of it. The English reference
1s not considered a direct translation of the foreign language,
but rather 1s preferably a contextual definition based upon the
word’s meaning within the text.

Definitions
Definitions 1n dictionaries are written for practical use.

Accordingly, word and sentence translations are preferably

written 1n modern English at a level acceptable to native

speakers. The types of phrases and words covered by the

English reference are preferably of great variety. The English

translation should therefore be highly readable and useful.

Hyper Notes
FIG. 4 15 a screen display showing a highlighted Japanese

word and a pop-up menu, including Japanese language anno-

tations of the Japanese word, according to the mnvention.

Hyper notes are provided for a great number of words and
phrases included 1n the system. Most of the explanations are
grammatical in nature, but others simply explain the passage
in further depth or rephrase the foreign language word or
phrase in simpler language. The notes have been written in the
foreign language because it 1s believed that this 1s the best way
for students of the language to improve their skills. As in the
main text, the yomi and meanings of the words are given 1n a
pop-up form.

Using the Flectronic Viewer Module
The electronic viewer module provides the following pull-

down menus: File, Edit, Words, View.

The File Menu 1ncludes:

Open (opens up a book for reading);

Close (closes a book);

Personal Dictionary (opens the personal dictionary);

Import Words (imports a tab delineated file into the per-

sonal dictionary);

5. Export Words (exports a tab delineated file into the per-
sonal dictionary); and Quit (quits the applications).

The Edit Menu Includes:

1. Undo (undoes a previously deleted entry in the personal
dictionary fields);

2. Cut (cuts a highlighted block of text in the personal dictio-
nary fields);

3. Copy (copies the selected text into the clipboard in either
the electronic viewer module or the personal dictionary);
and

4. Paste (pastes the copied text into the target field 1n the
personal dictionary).

The Words Menu includes:

1. Find (displays the search dialogue box);

2. Find Next (finds the next entry using the previously entered
search word);

3. Next (goes to the next word 1n the personal dictionary based
on the current sort setting);

4. Prey (goes to the previous word 1n the personal dictionary
based on the current sort setting);

5. Jump to Text (jumps from the personal dictionary to the
source ol the word in the original text); and

6. Flash Words (displays the words 1n the personal dictionary
in slide show fashion).

The View Menu includes:

1. Browse (sets the program to Browse Mode, indicated by the
arrow Cursor);

2. Edit (sets the program to Edit Mode, indicated by the
I-beam cursor);

1.
2.
3.
4.
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3. Show Note Guides (displays the location of the Notes in the
text of the viewer);

4. Show Notes (displays the Notes field 1n the personal dic-
tionary);

5. Show Info (displays the Word Information and sort control
button in the personal dictionary); and

6. Show Palette (displays the Word Display Palette with the
clectronic viewer module).

After a study session starts, a Table of Contents for the
selected book appears. By clicking on any item, the user 1s
able to go to the desired section of the book. The selected
chapter appears as a normal text file. The electronic viewer
window has a display region with a button to display the Table
of Contents. The current chapter name of the selected book 1s
also displayed 1n this area. To select a word or phrase 1n the
book, the user clicks on a word that 1s not understood and a
pop-up menu immediately appears (see FIG. 3). The pop-up
information contains the yomi, the English reference, and the
notes selection. If the pop-up menu does not appear, the
selected word 1s not referenced. The yomai also appears 1n the
pOp-up menu.

To view the English reference information the user selects
the English Reference from the pop-up menu and the infor-
mation appears next to the pop-up menu.

To see the Note associated with the text, the user selects
Notes from the pop-up menu and the Note appears 1n a sepa-
rate window. I the Notes item 1s gray (for example, as shown
in FIG. 3), no Note 1s available for the word. Notes also
include a pop-up reference feature. The first word 1n the text
with reference information has a black underbar beneath 1t.
This 1s the Word Pointer, which indicates the most recent
location for the pop-up menu and defaults to the first word. To
se¢c where a Note begins and ends, the user selects Show Note
Guides from the View Menu.

The electronic viewer module also provides a Palette. To
display the palette, the user selects Show Palette from the
View Menu. The Word Display Palette displays all the refer-
ence information for quick viewing. The arrow buttons move
the location of the Word Pointer and update the reference
information. The See Note command displays the Note if one
exists for the word and 1s gray 1f one 1s not present. The Add
to PD command automatically copies the word and its asso-
ciated information to the personal dictionary. If a Note 1s
present, 1t 1s also copied to the personal dictionary.

A limited amount of text can be copied from the book by
selecting Edit Mode from the View Menu, highlighting the
desired text, and selecting Copy from the Edit Menu. Words
can be searched for in the book by selecting Find from the
Words Menu.

Using the Personal Dictionary Module

FI1G. 5 1s ascreen display showing a Japanese word listed in
a personal dictionary, as well as a personal dictionary control
panel, according to the mvention. The personal dictionary
module 1n the exemplary embodiment of the invention 1s
implemented in a relational database that 1s optimized for
managing and studying words. Unlike electronic dictionaries
where only the word entries of the dictionary are searchable,
the personal dictionary module allows a user to search on
cach of the eight or more keys associated with a word, as
discussed above. To open the personal dictionary, the user
selects Personal Dictionary from the File menu or double
clicks on a Personal Dictionary icon.

The words contained in the personal dictionary are dis-
played 1n large fields with the word on the bottom, the yomi
above the word, and the English reference on top, as shown 1n
FIG. 5. In Browse Mode, clicking on a word alternately hides
and shows the word. This function 1s used to enhance review
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and study of the Main Control Buttons. The Main Control
Buttons are located just below the Word field. The arrow keys
display the next or previous words based on the sort key
indicated by the Sort Button 1n the bottom left corner. The
Show Notes button displays the Note information about the
Word. This button toggles to Hide Notes when the field 1s
displayed and Show Notes when hidden. Additional notes and
annotations can be entered directly. The Quick Search button
displays the word 1n a pop-window for quick search of a
single character. After the pop-up 1s displayed, the user can
click on the desired character to search. The Flash Words
button displays the words in the personal dictionary in slide
show fashion. Sort order or random order are selectable: sort
order uses the current sort order.

The Find button displays the search dialogue window.
Words are searchable by the following keys: Word, Yomu,
English Reference, Category, Source, Priority, or Date. The
personal dictionary supports logical “AND” searching for
cach of the above keys. The following features are supported:
1. Jump to Text—this button jumps control and display from

the personal dictionary to the source of the word in the

original text;

2. Show Info—this button displays the Word Information
Buttons, as well as the Date Indicator; this button toggles to
Hide Info when displayed, and Show Info when hidden;
and

3. Word Information—this button appears on the bottom of
the screen and has the following functions:

a. Current Sort—sets the sort order for the Dictionary to

cither Category, Source, Priority, or Date;

b. Category—provides for a set of predefined Categories

for words as well as the ability to add new Categories;
¢. Source—indicates the source of the Word: user entered
words are indicated by the user name or 11 not available,
by the default User;

d. fjrioﬂty—allows the user to assign a priority to a word

from 1 to 5; and

¢. Date Dlsplay—the date 1s displayed in the bottom right

hand corner; the date 1s automatically updated each time
the word 1s displayed.

Searching,

Both the electronic viewer module and the personal dictio-
nary module provide search features accessible via the Word
Menu. After selecting Find from the menu, the search dia-
logue appears.

The electronic viewer module 1ncludes a simple search
feature that allows the user to search for a string of text
anywhere 1n the book. The user enters the desired text and
clicks Find to execute the Search. Find Next searches for the
next occurrence of the word in the text.

In the personal dictionary, a slightly more complex search
teature 1s provided. The search dialogue allows the user to
enter multiple search terms. For example, a user can search
for a certain term 1n the ‘Economics’ category or the user can
look for a Kanji that has a certain reading. More search terms
result 1n increased search time. The search term for Word,
Yomi, Reference, Note, and Source are indexed based on the
first seven characters contained in the field. Characters
appearing after the seventh character in any of these fields are
not found with the ‘Starts With’ selection. Selecting ‘Con-
tains’ searches the entire text in the field.

To search, the user enters the desired word or character and
then selects ‘Starts With’ or ‘Contains’ from the menu. A
‘Starts With’ search 1s the fastest. The ‘Category’ search terms
are based on the category list. The integers 1 to 5 can be
entered for ‘Priority.” Date searching can be performed as ‘1s’
‘1s betfore’, or ‘1s after.” After entering the desired search
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information, the user clicks ‘Find’ to execute the Search. Find
Next searches for the next occurrence in the personal dictio-
nary.
Importing/Exporting Word Lists

Text files can be read 1nto the personal dictionary to make
data exchange with other programs and colleagues feasible.
The following format should be followed to allow accurate
importing. One may use a spreadsheet program to build the
word table and export the information as a tab delimited file.
If a word processor 1s used, the user must add an extra tab for
blank fields and follow the format listed below. In the exem-
plary embodiment of the invention, Export and Import uses
the following format:

Word 'TAB];
Pronunciation TAB};
Meaning 'TAB];

Notes TAB];
Category TAB];

Source TAB];
Priority 'TAB]; and
Date ‘Hard Return].

Setting up the Word field as column A 1n a spreadsheet and
then exporting as a text file results in this format. If a word
processor 1s used, one should also save as a text file. One
should not include any hard returns (user entered returns)
within the string of text for the given word. If given the option,
the user should elect to have soft returns (automatically
entered returns) deleted. To import, the user selects Import
Words from the File Menu, and then chooses the file for
import. To export, the user selects Export Words from the File
Menu, and then enters a name for the given file.

Although the invention 1s described herein with reference
to the preferred embodiment, one skilled 1n the art will readily
appreciate that other applications may be substituted for those
set forth herein without departing from the spirit and scope of
the present invention. For example, the invention may be used
to index 1images such that elements of the image are linked to
an external reference. Thus, an illustration of the human body
may include descriptive external resources for each of the
body’s internal organs, and would thereby aid 1n the study of
anatomy. Likewise, a video or other moving picture display,
for example animated displays, could be indexed such that the
picture could be stopped and various elements within a frame
of the picture could be examined through links to external
references. The mvention allows such application because it
does not embed 1nformation within the source matenal as 1s
the case with prior art hyperlink technology. Rather, the
invention creates a physical counterpart to the image 1n which
a selected 1image position defines an oifset that locates a
desired external reference. Accordingly, the invention should
only be limited by the claims included below.

We claim:

[1. A system for linking source material to reference mate-

rial for display comprising:

a source material image including a plurality of discrete
pieces having links to external reference materials com-
prising any of textual, audio, video, and picture nfor-
mation, said source material image stored in an elec-
tronic database;

means for determining an address on said electronic data-
base for the beginming position of said source material
1mage;

means for cutting said source material image into said
discrete pieces;

10

15

20

25

30

35

40

45

50

55

60

65

12

means for determining an address on said electronic data-
base for a start point and an end point of said discrete
pieces of said image based upon said beginning position
of said source material image;

means for recording said start and said end point addresses
in a look-up table;

means for selecting a discrete portion of said source mate-
rial image;

means for determining the address on said electronic data-
base of said selected discrete portion;

means for converting said address of said selected discrete
portion to an offset value from said beginning position
address of said source material 1image;

means for comparing said offset value with said recorded
start and end point addresses of said discrete pieces in
said look-up table;

means for selecting an external reference that corresponds
to said look-up table start and end point addresses; and

means for reproducing said external reference.]

[2. The system of claim 1, further comprising:

a linking engine for linking said source material to said
reference information on any of a word-by-word and
phrase-by-phrase basis.]

[3. The system of claim 2, said linking engine further

comprising;

word cut means for dividing said source material into dis-
crete pieces;

linking means for establishing at least one link between
cach of said discrete pieces and said reference informa-
tion;

compiler means for assembling an integrated source 1mage
from said discrete pieces;

indexing means for linking said assembled discrete pieces
to said reference information. ]

[4. The system of claim 3, said linking engine further

comprising;

means for building an index to link each of said source
material pieces to said reference information.}

[5. The system of claim 4, wherein said index links said
source material pieces to said reference information based
upon the value of the offset of the starting and ending position
addresses of said source material pieces from the beginning
position address of said integrated source image.]

[6. The system of claim 5, wherein said offset locates said
reference information to a corresponding source material
piece based upon offset occurrence within a range defined by
the value of the offsets of the starting and ending point
addresses of said source material pieces from said beginning
position address of said integrated source image.]

[7. The system of claim 1, further comprising:

means for manipulating said stored source material and
reference information with at least two user keys.]

[8. A method for linking source material to reference mate-

rial for display, comprising:

determiming the beginning position address of a source
material 1mage stored in an electronic database, said
source material image including a plurality of discrete
pieces having links to external reference materials com-
prising any of textual, audio, video, and picture nfor-
mation;

cutting said source material image into said discrete pieces;

determining a starting point address and an ending point
address of said discrete pieces of said image based upon
said beginming position address of said source material
1mage;

recording said starting and said ending addresses 1n a look-
up table;
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selecting a discrete portion of said source material 1mage;

determining the address of said selected discrete portion;

converting said address of said selected discrete portion to
an offset value from said beginning position address of
said source material 1mage;

comparing said offset value with said recorded start and

end point addresses of said discrete pieces 1n said look-
up table;

selecting an external reference that corresponds to said

look-up table start and end point addresses; and
reproducing said external reference.]

[9. In a language learning method, a method for linking
source material to reference material for display, comprising
the steps of:

reading a foreign language source material 1mage includ-

ing a plurality of discrete pieces having links to external
reference materials comprising any of textual, audio,
video, and picture information with an electronic
viewer;

accessing reference materials on selected portions of said

source material 1image;

determining the beginning position address of said source

material 1image;

cutting said source material image into said discrete pieces;

determining a start point address and an end point address

of said discrete pieces of said image based upon said
beginning position address of said source material
1mage;

recording said start and said end point addresses 1n a look-

up table;

selecting a discrete portion of said source material image;

determining the address of said selected discrete portion;

converting said address of said selected discrete portion to
an ollset value from said beginming position address of
said source material image;

comparing said offset value with said recorded start and

end point addresses of said discrete pieces 1n said look-
up table;

selecting an external reference that corresponds to said

look-up table start and end point addresses; and
reproducing said external reference.]

[10. The method of claim 9, further comprising the step of:

linking said source maternial to said reference information

with a linking engine on any of a word-by-word and
phrase-by-phrase basis.]

[11. The method of claim 10, said linking step further
comprising the steps of:

dividing said source material into discrete pieces;

establishing at least one link between each of said discrete

pieces and said reference information;

assembling an integrated source image from said discrete

pieces; and

linking said assembled discrete pieces to said reference

information. ]

[12. The method of claim 11, said linking step further
comprising the step of:

building an 1ndex to link each of said source material pieces

to said reference information.]

[13. The method of claim 12, wherein said index links said
source material pieces to said reference imnformation based
upon the offset between the starting position address for said
source material pieces and the beginning position address of
said integrated source image.}

[14. The method of claim 13, wherein said offset locates
said reference information to a corresponding source material
piece based upon offset occurrence within a range defined by
the value of the offsets of the starting and ending position
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addresses of said source material pieces from said beginning
position address of said integrated source image.]

[15. In a language learning system, a system for linking
source material to reference material for display, comprising;:

a text image 1including a plurality of discrete pieces having,

links to external reference materials comprising any of
textual, audio, video, and picture information;

means for determining the beginning position address of

said text image;

means for cutting said text image 1nto said discrete pieces;

means for determining a starting point address and an

ending point address of said discrete pieces of said
image based upon said beginning position address of
said source material 1image;

means for recording said starting and said ending point

addresses 1n a look-up table;

means for selecting a discrete portion of said text image;

means for determiming the address of said selected discrete

portion;

means for converting said address of said selected discrete

portion to an offset value from said beginning position
address of said source material 1mage;

means for comparing said offset value with said recorded

start and end point addresses of said discrete pieces 1n
said look-up table;

means for selecting an external reference that corresponds

to said look-up table start and end point addresses; and
means for displaying said external reference.}

[16. In a language learning method, a method for linking
source material to reference material for display, comprising
the steps of:

determining the beginning position address of a text image,

said text image including a plurality of discrete pieces
having links to external reference materials comprising
any of textual, audio, video, and picture information;
cutting said source material image 1nto said discrete pieces;
determining a starting point address and an ending point
address of said discrete pieces of said image based upon
said beginning position address of said text image;

recording said starting and said ending point addresses 1n a

look-up table;

selecting a discrete portion of said text image;

determiming the address of said selected discrete portion;

converting said address of said selected discrete portion to
an olfset value from said beginning position of said text
1mage;

comparing said offset value with said recorded start and

end point addresses of said discrete pieces 1n said look-
up table;

selecting an external reference that corresponds to said

look-up table start and end point address; and
displaying said external reference.}

17. A method for linking source material to external refer-
ence materials for display, the method comprising the steps
of

determining a beginning position address of a source mate-

rial stored in an electronic database;

cutting the source material into a plurality of discrete

pleces,

determining a starting point address and an ending point

address of at least one of the plurality of discrete pieces
based upon the beginning position address;

recording in a look up table the starting and ending point

addresses

linking at least one of the plurality of discrete pieces to at

least one of a plurality of external veference materials,
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the plurality of external reference materials comprising
any of textual, audio, video, and picture information;

selecting a discrete portion of an image of the source
material;

determining a display address of the selected discrete por- 5

tion of the source material image;

converting the display address of the selected discrete por-

tion to an offset value from the beginning position
address;

comparing the offset value with the starting and ending 10

point addrvesses recovded in the look-up table to identify
one of the plurality of discrete pieces;

selecting one of the plurality of external veference materi-

als corresponding to the identified one of the plurality of
discrete pieces; and

displaving the selected one of the plurality of external

reference materials.

18. The method of claim 17, wherein cutting the source
material into a plurality of discrete pieces is done manually.

19. The method of claim 17, wherein cutting the source
material into a plurality of discrete pieces is done automati-
cally.

20. The method of claim 19, whervein automatically cutting
the source material into a plurality of discrete pieces is done
using a grammar parser.

21. The method of claim 19, wherein automatically cutting
the source material into a plurality of discrete pieces is done
without using tags.

22. The method of claim 19, wherein automatically cutting
the source material into a plurality of discrete pieces is done
without reference to any tags which may be located in the

source material.
23. The method of claim 17, wherein the link is a hyperlink.

24. The method of claim 17, wherein the link is an address
of the selected one of the plurality of external veference mate-
rials.

25. The method of claim 17, whevein the link is veference
information for vetrieving the selected one of the plurality of
external veference materials.

26. The method of claim 17, wherein the source material is 40
text based source material.

27. The method of claim 17, wherein the source material is
image based source material.

28. The method of claim 17, wherein the source material is
graphic based source material.

29. The method of claim 17, wherein the source material is
audio based source material.

30. The method of claim 17, wherein the source material is
video based source material.

31. The method of claim 17, wherein the source material is 50
a combination of two or move of text based source material,
image based source material, graphic based source material,
audio based source material, and video based source mate-
rial.

32. The method of claim 17, wherein linking at least one of 55
the plurality of discrete pieces is done manually.

33. The method of claim 17, wherein linking at least one of
the plurality of discrete pieces is done automatically.

34. A system for linking source material to external vefer-
ence materials for display, the system comprising:

means for determining a beginning position addrvess of a

source material stored in an electronic database;
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means for cutting the source material into a plurality of

discrete pieces;

means for determining a starting point address and an

ending point addrvess of at least one of the plurality of
discrete pieces based upon the beginning position
address;

means for recording in a look up table the starting and

ending point addresses;

means for linking at least one of the plurality of discrete

pieces to at least one of a plurality of external veference
materials, the plurality of external reference materials
comprising any of textual, audio, video, and picture
information,

means for selecting a discrete portion of an image of the

source material;

means for determining a display address of the selected

discrete portion of the source material image;

means for converting the display address of the selected

discrete portion to an offset value from the beginning
position address;

means for comparing the offset value with the starting and

ending point addresses recovded in the look-up table to
identify one of the plurality of discrete pieces;

means for selecting one of the plurality of external refer-

ence materials corrvesponding to the identified one of the
plurality of discrete pieces; and

means for displaying the selected one of the plurality of

external veference materials.

35. A method for linking textual source material to external
reference materials for display, the method comprising the
steps of:

determining a beginning position address of textual source

material stored in an electronic database;

cutting the textual source material into a plurality of dis-
crete pleces,

determining a starting point address and an ending point
address of at least one of the plurality of discrete pieces
based upon the beginning position address;

recording in a look up table the starting and ending point
addresses

linking at least one of the plurality of discrete pieces to at
least one of a plurality of external veference materials,
the plurality of external reference materials comprising
any of textual, audio, video, and picture information;

selecting a discrete portion of an image of the textual
source material;

determining a display address of the selected discrete por-
tion of the textual source material image;

converting the display address of the selected discrete por-
tion to an offset value from the beginning position
address;

comparing the offset value with the starting and ending
point addrvesses recovded in the look-up table to identify
one of the plurality of discrete pieces;

selecting one of the plurality of external reference matevi-
als corresponding to the identified one of the plurality of
discrete pieces; and

displaving the selected one of the plurality of external
reference materials.

% o *H % x



	Front Page
	Drawings
	Specification
	Claims

